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Getting started

1 Getting started

Topics covered in this chapter:

*  Customized installation media
. Where to get help

* Installation Types

. Operating Requirements

Thank you for choosing AMS Machinery Manager. Let's get started!

Your AMS Machinery Manager package includes:
O Quick Start Guide

O  Software Installation DVD

O Manuals DVD

1.1 Customized installation media

Based on your order, the Software Installation DVD contains the following:

. Standalone (Single User) or Network installation
. AMS Machinery Manager technologies

. Number of licensed users

To add a technology or more licensed users, contact your Emerson Process Management
Sales Representative.

1.2 Where to get help

AMS Machinery Manager Help

Launch AMS Machinery Manager and select Help from the main menu.

AMS Machinery Manager Manuals DVD

Your AMS Machinery Manager package includes a disc with user manuals in PDF format.

Software Registration

Phone: Toll free 888.367.3774, option 2 (U.S. and Canada)
+63.2.702.1111 (Rest of world)

Email: wwcs.custserv@AP.EmersonProcess.com

Web: http://www.mhm.assetweb.com/reg
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1.3

1.3.1

Product Support

Emerson provides a variety of ways to reach your Product Support team to get the answers
you need when you need them:

Phone Toll free 800.833.8314 (U.S. and Canada)
+65.6770.8711 (Europe and Middle East)
+63.2.702.1111 (Asia Pacific)

Email mhm.custserv@emerson.com

Web http://www.assetweb.com/mhm and select Product Support

For additional contact information for specific countries, visit http://www.SureService.com
and select Technical Support and Customer Service.

For Machinery Health experts in your area, visit http://www.assetweb.com/mhm and
select Contacts For Your Area.

Installation Types

There are two main types of AMS Machinery Manager installations:

. Standalone (or Single-user standalone)

. Network (or Single-user network and Multiple-user network).

Standalone installation

A Standalone system allows you to use periodic technology with one computer and CSI
Machinery Health Analyzers. A standalone installation indicates you have a single copy of
AMS Machinery Manager with a single serial number on one computer.

You can install these components:

. AMS Machinery Manager
. AMS Standalone Data Transfer (on a different computer)
. AMS Machinery Manager ODBC Driver

MHM-97402, Rev 23
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Figure 1-1: Standalone system example

This example does not attempt to show all supported hardware options.

Csl 2140
- |—usa—b
SI 2130
Q SERIAL Data on local hard drive
CsSl 2125-I1s use SERIAL;
v i
IR Camera(s) Qil Analyzer
1.3.2 Network installations

A network system allows you to use online technology and periodic technology. AMS
Machinery Manager communicates with a CSI Machinery Health Monitor using a network
connection. A network system is deployed on a local area network (LAN) or a wide area
network (WAN).

You can install these components:

. AMS Machinery Manager

. Online Server
. Secondary Database Server
. Data Import Server

. AMS Machinery Manager Data Import Client

. AMS Standalone Data Transfer (on a different computer)
. AMS Machinery Manager ODBC Driver

. Machine History Viewer

. Collaboration Tool

. CSI Data Provider
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Single-user and multiple-user LAN

A Single-user network indicates you have a Network Server and a Client installed on one
computer and have one serial number. Single-user network allows the Client to be
installed on other computers in the network. However, only one user can log in at a time.
This installation is used for single user customers with an online system.

A Multiple-user network indicates you have a Network Server and a Client installed on a
server-class computer, and the Client installed on other computers in the network.
Multiple users can log in at the same time.

Figure 1-2: Local area network system example

This example does not attempt to show all supported hardware or configuration options.
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Multiple-user WAN

The WAN system is designed to allow remote AMS Machinery Manager users to load,
dump, and view data over wide area networks, such as private networks, virtual private

networks("), or the Internet.

Figure 1-3: Wide area network system example

This example does not attempt to show all supported hardware or configuration options.
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1.4

Operating Requirements

Emerson Process Management recommends the following resources for AMS Suite:
Machinery Health™ Manager 5.61:

1.4.1

Servers

Minimum requirements

Supported Operating Windows Server 2012 R2 Standard Edition("), Windows Server 2008 SP2 Standard Edition,
Systems Windows Server 2008 R2, or Windows Server 2003 R2 SP2
Processor/ | Portable 1.83 GHz Dual Core or better, 2 GB of RAM or more
Memory Systems
Online Server-class 2.33 GHz Dual Core or better, 2 GB of RAM or more
Systems
Network Ethernet (TCP/IP protocol)
Browser Internet Explorer 7 or later

Screen Resolution

XGA (1024 x 768) or better

Requirements for laptops used with CSI 2600 systems

Supported Operating Windows 8.1 Professional("), Windows 8 Pro, Windows 7 Professional SP1, Windows 7
Systems Ultimate, or Windows 7 Enterprise

Processor/Memory 1.5 GHz or better, 2 GB of RAM or more

Hard drive capacity 250 GB or greater

RS232 One available RS232 interface

Network Ethernet (TCP/IP protocol)

Browser Internet Explorer 7 or later

Screen Resolution

XGA (1024 x 768) or better

Additional recommendations

Media

DVD drive required for installation

Virtualization System

e Remote Desktop Services (Windows Server 2012, Windows Server 2008)
e Terminal Server (Windows Server 2003)

e Citrix XenApp 6.5 (Windows Server 2008)

e Citrix XenApp 5.0 (Windows Server 2003)

e VMware ESXi 5.5 (Windows Server 2012)

e VMSphere 5.5 (Windows Server 2012)

e Hyper-V (Microsoft System Center 2012 R2 Virtual Machine Manager)

MHM-97402, Rev 23
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Antivirus

AVG® Network Security 2014

Symantec™ Endpoint Protection 12.1 RU4

McAfee™ All Access 2014 —Refer to Knowledge Base Article (KBA) NK-1400-0342 for
antivirus configuration.

Trend Micro™ Premium Security — Refer to KBA AK-1400-0080 for antivirus
configuration.

Norton 360 Version 2014 — Refer to KBA AK-1400-0079 for antivirus configuration.

(1) Requires Microsoft .NET Framework 3.5 SP1, available from the Microsoft web site. Because AMS Machinery Manager does not require
an Internet connection for installation, Emerson recommends installing .NET Framework 3.5 SP1 before AMS Machinery Manager.

Important

If you intend to install Machine History Viewer or CSI Data Provider, you must install Internet
Information Services before installing AMS Machinery Manager. The AMS Machinery Manager
installation makes important changes to the IS setup that you would otherwise have to configure
manually with the assistance of Product Support.

1.4.2 Workstations

Minimum requirements

Supported Operating Windows 8.1 Professional(!), Windows 8 Pro, Windows 7 Professional SP1, Windows 7
Systems Ultimate, or Windows 7 Enterprise

Processor/Memory 1.5 GHz or better, 2 GB of RAM or more

Network Ethernet (TCP/IP protocol)

Browser Internet Explorer 7 or later

Screen Resolution

XGA (1024 x 768) or better

Communication requirements

RS232 * For communications with analyzers prior to the CSI 2130 Machinery Health Analyzer, a
PC must have an RS232 serial port, or use a serial-to-USB cable.
 For communication with the Spectro 5200 Trivector™ Analyzer, a PC must have an
RS232 serial port, or use a serial-to-USB cable.
UsB e AUSB 2.0 portis required for communications with the CSI 2140 Machinery Health

Analyzer and CSI 2130 Machinery Health Analyzer.
A USB 2.0 port is required for communication with the WDA Image Capture Kit.

Additional recommendations

Media

DVD drive required for installation
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Antivirus * AVG® Network Security 2014

» Symantec™ Endpoint Protection 12.1 RU4

*  McAfee™ All Access 2014 —Refer to Knowledge Base Article (KBA) NK-1400-0342 for
antivirus configuration.

 Trend Micro™ Premium Security — Refer to KBA AK-1400-0080 for antivirus
configuration.

e Norton 360 Version 2014 — Refer to KBA AK-1400-0079 for antivirus configuration.

(1) Requires Microsoft .NET Framework 3.5 SP1, available from the Microsoft web site. Because AMS Machinery Manager does not require
an Internet connection for installation, Emerson recommends installing .NET Framework 3.5 SP1 before AMS Machinery Manager.

1.4.3 Localization considerations

You may license AMS Machinery Manager software in English or a localized (translated)
version. You must specify a language at the time you purchase your software licenses.
Only the language you license will be on your software installation DVD. Follow these
guidelines when preparing to install a localized version of AMS Machinery Manager.

Note

You may need to change your computer name before installing AMS Machinery Manager. A valid
computer name can have numbers 0-9, uppercase and lowercase letters A-Z, and the hyphen (-).
Special characters (<>;:" * +=\ | ?,), accented characters, and other multibyte charactersin a
computer name can cause problems and interfere with a successful installation of AMS Machinery
Manager software. Computer names cannot have only numbers, nor can they contain spaces.

Windows 7 Professional, Windows 7 Enterprise, Windows Server 2008, and Windows
Server 2012

Recommendations for Windows without Multilingual User Interface (MUI) support, for
example: Microsoft Windows 7 Professional, Windows 7 Enterprise, Windows Server 2008,
and Windows Server 2012.

. Installing localized AMS Machinery Manager is supported on a Windows system of
the same language with default regional settings. For example, install AMS
Machinery Manager (German) on Windows (German).

. Installing localized AMS Machinery Manager on an English Windows system is not
recommended. If you install localized AMS Machinery Manager on Windows
(English), text may not display properly.

. When you upgrade AMS Machinery Manager, the language must match the
currently installed AMS Machinery Manager language. For example, update AMS
Machinery Manager v5.51 (German) to AMS Machinery Manager v5.6 (German). To
change the AMS Machinery Manager language you need a full installation instead of
an upgrade.

. Avoid changing Windows regional settings. Changes may cause unexpected
behavior in AMS Machinery Manager.

. Installing English AMS Machinery Manager on a non-English Windows system is
supported for Windows (Japanese) only.
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AMS Machinery
Manager language

Windows language
edition

Windows regional settings

Supported

Localized version

Native language

Default (Native language)

Yes (preferred)

English

English

Default

Yes

Localized version

English

Default

Not recommended

English

Native language

Default (Native language)

Japanese only

English

English

Changed to non-default, non-English No

Windows 8.1, Windows 8, and Windows 7 Ultimate

Recommendations for Windows with Multilingual User Interface (MUI) support, for
example: Microsoft Windows 8.1, Windows 8, and Windows 7 Ultimate.

Installing localized AMS Machinery Manager on a Windows system where the
matching language pack and regional settings have already been installed. For
example, install AMS Machinery Manager (German) on Windows after installing the
German language pack.

When you upgrade AMS Machinery Manager, the language must match the
currently installed AMS Machinery Manager language. For example, update AMS
Machinery Manager v5.51 (German) to AMS Machinery Manager v5.6 (German). To
change the AMS Machinery Manager language you need a full installation instead of
an upgrade.

One language of AMS Machinery Manager is available per installation. If you change
your regional settings or language pack after installing AMS Machinery Manager,
strings may not display properly. Use the regional settings and language pack that
match the language you licensed for AMS Machinery Manager.

AMS Machinery
Manager language

Windows language

edition Windows regional settings Supported

Localized version

MUI with language pack | settings match language pack Yes (preferred)

Localized version

MUI with language pack = English No (translated strings may

not display correctly)
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2.1

Standalone installation

Topics covered in this chapter:

*  Install AMS Machinery Manager
. Launch AMS Machinery Manager
*  Update or repair the installation

Install AMS Machinery Manager

Prerequisites
Verify the client computer meets the operating requirements for a workstation.

If you are upgrading your software, back up your database before completing the software
update. Your databases require reindexing to work with the new software. If you need to
reinstall the previous version of software, be aware that any database you open with the
new software will be reindexed and will no longer work with any previous version.

Procedure

1. Log on to the computer as a user with administrator rights.

2. Insert the AMS Machinery Manager Software Installation DVD and openiitin
Windows Explorer.

3. Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

4.  Ifaprompt toinstall Microsoft .NET Framework 4.0 appears, choose to install this
software and allow the system to reboot, (if required).

The AMS Machinery Manager installation begins automatically after reboot.

Accept the license agreement and click Next.

At the ATTENTION!! dialog, click Yes if you are installing the software for the first
time. If you are upgrading your software, this is a reminder to stop the installation
and back up your database first. Click No to stop the installation.

7.  The setup program verifies that your system meets the minimum requirements. If
they are met, the Options page dialog appears. If they are not met, a message
displays more information. Update the computer to meet the requirements or
contact Product Support.

8.  (Optional) At the Select Features to Install pane, you can change defaults for your
installation.

MHM-97402, Rev 23 11
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Select Feature to Install: | dF Destination Location ||_J Data Location

= [¥] AMS Machinery Manager Descrighion:
= Network Serve This will install AMS Machinery Manager Stand Alone Server.
Dl At A
s
7| g Single-User
S Patabas To install in another directory, click ‘Browse’ and choose another

2 ?’_ directory.
L atas Import Senve Destination Folder
C:\RBMsuite Browse
The install program can create shortcuts to your AMS Machinery
Manager applications. Please choose where you would like to have
shortcut icons created.
Windows Desktop
! Start Button Programs Folder
Disk space requirements:
+ The following file has been found in your Data Directory Drive Dusk Size Space Avaisbie Requred
*: Replace customer data file Csitom sup CA 2980GB 2075GB 4436 MB
Replace customer data fike Example rbm
Restore Default

Notes

e Use the default settings and directory names unless there is a particular reason to change
them. Using the defaults results in a trouble-free installation and streamlined interaction
with Emerson Product Support, should a problem ever arise.

e Ifyou are updating the software, this screen also displays the message, “The following file
has been found in your Data Directory” followed by file names. You can check the box by
the file to overwrite the file.

* If you are updating your software, some fields may be disabled. If you want to update your
software and move to a different computer, contact Emerson Product Support.

9. Click Install to start the installation.

The Installing Components screen displays and shows the status of the installation.

Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you
may need to contact Emerson Product Support.

10. Ifyou are using Windows Firewall, grant access to programs published by Emerson
Process Management when prompted.

11.  Continue through the installation steps and follow prompts.

12.  When the Serial dialog appears, click Register Product to register the software now, or
click Close to skip registration.

12 MHM-97402, Rev 23
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“ Serial ===
General Information
Infesmation for - |C:\RBM kBN L
Senial Ho. |I Begater Product
System : [Single Uses Register Haidwae Key
Shah |Unregst9|ed[50 days keft]

Product Code | Package Descrpbon Licanzez | =
474507 51 4500 Trarment Ploting Module

1
472003 Wibiview Platinum 1 =
472050 Mzpech 1 Prit.
472m4 AuboStat 1 —
472100 RFWatch 1
470003 RBMView 1
479500 Infrared Analysis Gold 1 Geneisle EPM
473002 Motoriew Gold 1
478000 Ulra Mansger 1 .
£3poee Lo i . -
Cusrent installed version of MHM EXE - AS50 Buld # 778
Mew users can register AMS Machineny Manager at hitp:/fvasw.emen ocess com/AMSMachinesy anzagerR egistration

Note
To register later, open Windows Explorer, go to C:\RBMsuite\sys and double-click Serial.exe.

a. Inthe Serial dialog, click Register Product.

The Register Product dialog appears. You need the Serial No. and Request No.
during registration.

b. Contact Product Support to register.

Phone: Toll free 888.367.3774, option 2 (U.S. and Canada)
+63.2.702.1111 (Rest of world)

Email: wwcs.custserv@AP.EmersonProcess.com

Web: http://[www.mhm.assetweb.com/reg

Enter the Response code given to you by a Product Support representative.
d. Click OK.

The Register Product dialog closes.

e. Inthe Serial dialog, verify the Status is "Registered."
f. Click Close.

Your software is registered.
The installation automatically continues.

13.  Onthe Finish page, click Finish to complete the installation.

If the computer requires a reboot, Restart Now is selected on the Finish page. Allow
the system to reboot before attempting to run the software.

MHM-97402, Rev 23 13
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2.2 Launch AMS Machinery Manager

Now that you have installed and registered AMS Machinery Manager, you are ready to
launch AMS Machinery Manager.

Procedure

1. Go to Start > Programs (All Programs) > AMS Machinery Manager.
Select AMS Machinery Manager.
Log in when prompted.

a. Initially, Administrator is the default user. Leave the password blank and click OK.

b. Ifyou use a different user, enter the username and password and click OK.

See the Administration topics in AMS Machinery Manager Help to set the
Administrator password and create a new user.

2.3 Update or repair the installation

Note
You must register the software when you update the software.

Prerequisites
Close all AMS Machinery Manager programs.

Stop AMS Machinery Manager services.

Procedure

1. Insert the AMS Machinery Manager Software Installation DVD and open it in
Windows Explorer.

2. Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

3. At the startup screen choose Add/Update or Repair and click Next.

At the Options pane, choose the features to install or leave the defaults selected for
an update.

5. In the list labeled The following files have been found in your Data Directory, check the box
by a file to replace the file on your computer with the file from the installation.

6. Click Install to start the installation.

14 MHM-97402, Rev 23
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The Installing Components screen displays the status of the installation.

Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you
may need to contact Emerson Process Management Product Support.

Continue through the installation steps and follow prompts.

On the Finish page, click Finish to complete the installation.

If the computer requires a reboot, Restart Now is selected on the Finish page. Allow
the system to reboot before attempting to run the software.
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3 Network installation

Topics covered in this chapter:

Network installation overview

Install the Network Server

Install the AMS Machinery Manager Client

Launch AMS Machinery Manager Client

Install a Secondary Database Server

Install an Online Server

Install Data Import Server and Data Import Client
Install Collaboration Tool

Update or install new features on the Network Server

3.1 Network installation overview

Important

If you intend to install Machine History Viewer or CSI Data Provider, you must install Internet
Information Services before installing AMS Machinery Manager. The AMS Machinery Manager
installation makes important changes to the IS setup that you would otherwise have to
configure manually with the assistance of Product Support.

If you are upgrading your software, back up your database before completing the software
update. Your databases require reindexing to work with the new software. If you need to
reinstall the previous version of software, be aware that any database you open with the new
software will be reindexed and will no longer work with any previous version.

Prerequisites

Ensure each computer meets the minimum system operating requirements.

Procedure

1.

Install the Network Server on the server first.

Install the AMS Machinery Manager Client on a workstation.

Install secondary servers and clients on other computers on the network.

You can install Online Server, Secondary Database Server, Data Import Server, Data

Import Client, and AMS Machinery Manager Client on other computers in the
network.

Postrequisites

MHM-97402, Rev 23

Configure service accounts and firewall settings for each computer, if necessary.

Refer to Chapter 6 for more information.
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3.2

18

. Network installations require further configuration for each CSI Machinery Health
Monitor.

For more information, open Help in AMS Machinery Manager and choose
Administration > Online Server.

Install the Network Server

The Network Server installation procedure installs and configures the programs and
services required for the primary server. You can choose to install additional features.

The installation creates a shared folder from which you install the Client or other licensed
components on other machines on this network. By default, the folder is C:\RBMnet\ and is
shared as \\Servername\RBMnet where Servername is the network computer name.

Prerequisites
Ensure the computer meets the minimum system operating requirements.

If you are upgrading your software, back up your database before completing the software
update. Your databases require reindexing to work with the new software. If you need to
reinstall the previous version of software, be aware that any database you open with the
new software will be reindexed and will no longer work with any previous version.

To install AMS Machinery Manager on a drive other than C, create a shared folder named
RBMnet on the drive where you want to install the software, prior to starting the
installation. After installation is complete, an administrator may need to modify the shared
folder's security permissions to allow access from other computers.

Important

If you intend to install Machine History Viewer or CSI Data Provider, you must install Internet
Information Services before installing AMS Machinery Manager. The AMS Machinery Manager
installation makes important changes to the IIS setup that you would otherwise have to configure
manually with the assistance of Product Support.

Procedure

Log on to the computer as a user with administrator rights.

2. Insert the AMS Machinery Manager Software Installation DVD and open it in
Windows Explorer.

3. Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

4.  Accept the license agreement and click Next.
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If a prompt to install Microsoft .NET Framework 4.0 appears, choose to install this
software and allow the system to reboot, (if required).

The AMS Machinery Manager installation begins automatically after reboot.

At the ATTENTION!! dialog, click Yes if you are installing the software for the first
time. If you are upgrading your software, this is a reminder to stop the installation
and back up your database first. Click No to stop the installation.

The setup program verifies that your system meets the minimum requirements. If
they are met, the Options page dialog appears. If they are not met, a message
displays more information. Update the computer to meet the requirements or
contact Product Support.

At the Options page dialog, make changes to the Select Features to Install list, if
desired.

Network Server and Client are checked as the preferred defaults. You can select
other features, if available. Refer to corresponding sections for more information
about additional features.

[ L 3 = . »
Select Feature to Install : | *s Destination Location | Data Location

- ["] AMS Machinery Manager
i_J Ii“?:

== é' AMS Machinery Manager Client
{71 g DataImport Client

Description:
This will install AMS Machinery Manager Network Server.

To install in another directory, click ‘Browse' and choose another

——

4
[HF148) Databas directory.
| s E A THE RBMNET DIRECTORY WILL BE SHARED AUTOMATICALLY
(s FOR YOUR COMVENIENCE, EMERSON PROCESS MANAGEMENT
{7]™ DataImport Server RECOMMENDS THAT THE SHARED NAME IS 'RBMNET*

Destination Folder:

WWINSTALLTEST\REMnet Browse

The install program can create shortcuts to your AMS Machinery
Manager applications. Please choose where you would like to have
shortcut icons created.

Windows Desktop
[¥] Start Button Programs Folder

Disk space requirements:

D) The following file has been found in your Data Directory Drive Disk Size Space Avaiable Required
"] Replace customer data file Csibm sup CA 59.9GB 382GB 2400 MB
"] Replace customer data file Example rbm

Restore Default

e Database Server, Section 3.5

* Online Server, Section 3.6

e Datalmport Server, Section 3.7
» Datalmport Client, Section 3.7

Notes

e Use the default settings and directory names unless there is a particular reason to change
them. Using the defaults results in a trouble-free installation and streamlined interaction
with Emerson Product Support, should a problem ever arise.

* If you are updating the software, this screen also displays the message, “The following file
has been found in your Data Directory” followed by file names. You can check the box by
the file to overwrite the file.
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10.

11.

e Ifyou are updating your software, some fields may be disabled. If you want to update your
software and move to a different computer, contact Emerson Product Support.

Follow these steps if you need to change the default locations:

a. Ifyou need to change the installation directory, select Network Server in the
features list and open the Destination Location tab.

Browse to the location. The Destination Folder is in Universal Naming Convention

(UNC) format. Ared error icon flashes if the path is invalid.

b. If you need to change where your data is stored, select Network Server in the
features list and open the Data Location tab.

Browse to the location. The path is in Universal Naming Convention (UNC)
format. A red error icon flashes if the path is invalid.

Click Install to start the installation.

The Installing Components screen displays the status of the installation.

Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you

may need to contact Emerson Process Management Product Support.

If you are using Windows Firewall, grant access to programs published by Emerson
Process Management when prompted.

When the Serial dialog appears, click Register Product to register the software now, or

click Close to skip registration.

| —# Serial o =@
General Information
Cloze
(LS A S TALLTE S ThREMrnet \ HEM sutelsys!
0 X q
Seriel No.: | Fegester Product
Syshem : |
Statuz : |Um\sa;|'sbsredIEU daye lait)
Froduct Code | Package Desciiplion Licenzes | =
AT4507 51 4500 Transient Floting Module 1
472008 Wit Transmither 1 =
472003 Viblwhew Platinum 1 Print
472050 Mzpech 1
472013 AugtoStat 1
472000 RF Wwiatch 1
A70003 RBMiew 20 Generate EPM
479500 Infraied Analysiz Gold 1
473002 Motoriew Gold 1 =
wrnnnn am b e 1

4 i

Cunert instaled version of MHM.EXE | AS.S0 Build 8 778

MNew users can register AMS Machinery Manages st hiip:/fvasw, emersonprocess com/AMS M achineyh ansgerRegisiation

Note

To register later, on the Network Server, go to C:\RBMnet\RBMsuite\sys and double-click

Serial.exe.

a. Inthe Serial dialog, click Register Product.
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The Register Product dialog appears. You need the Serial No. and Request No.
during registration.

b. Contact Product Support to register.

Phone: Toll free 888.367.3774, option 2 (U.S. and Canada)
+63.2.702.1111 (Rest of world)

Email: wwcs.custserv@AP.EmersonProcess.com

Web: http://www.mhm.assetweb.com/reg

c. Enter the Response code given to you by a Product Support representative.

The code is only valid for your computer.
d. Click OK.

The Register Product dialog closes.

e. Inthe Serial dialog, verify the Status is "Registered."
f. Click Close.

Your software is registered.

The installation automatically continues, installing the Client and any other selected
features.

12.  Continue through the installation steps and follow prompts.
13.  On the Finish page, click Finish to complete the installation.

If the computer requires a reboot, Restart Now is selected on the Finish page. Allow
the system to reboot before attempting to run the software.

Postrequisites

Install AMS Machinery Manager Client on a workstation.

3.3 Install the AMS Machinery Manager Client

Run the AMS Machinery Manager installation program (RBMsetup.exe) on a computer in
the AMS Machinery Manager network. Choose the Client option.

Prerequisites

. Install the AMS Machinery Manager Network Server on the server first.
. Verify the client computer meets the operating requirements for a workstation.

. Verify the workgroup or domain settings match on the Network Server computer
and Database Server computer.

Procedure

1. Logon to the computer as a user with administrator rights.
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Browse to the shared folder on the Network Server. For example, \\Servername
\RBMnet, where Servername is the computer's name.

Important
Do NOT use a mapped drive path.

Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

At the Options page dialog, make changes to the Select Features to Install list, if
desired.

You can install certain additional features on other computers in the AMS Machinery
Manager network. The Network Server option is disabled here since only one
network server is allowed on an AMS Machinery Manager network.

The Client is selected and default locations are set. If desired, select the Shortcuts tab
and select Add shortcuts to desktop

Click Install to start the installation.

The Installing Components screen displays the status of the installation.

Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you
may need to contact Emerson Process Management Product Support.

Continue through the installation steps and follow prompts.

On the Finish page, click Finish to complete the installation.

If the computer requires a reboot, Restart Now is selected on the Finish page. Allow
the system to reboot before attempting to run the software.

Launch AMS Machinery Manager Client

Now that you have installed and registered AMS Machinery Manager, you are ready to
launch the AMS Machinery Manager Client.

Procedure

1. Go to Start > Programs (All Programs) > AMS Machinery Manager.
2. Select AMS Machinery Manager Client.

3.  Loginwhen prompted.
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a. Initially, Administrator is the default user. Leave the password blank and click OK.

b. Ifyou use a different user, type in the username and password and click OK.

See the Administration topics in AMS Machinery Manager Help to set the
Administrator password and create a new user.

3.5 Install a Secondary Database Server

Prerequisites

Install the AMS Machinery Manager Network Server on the server first.

Verify the workgroup or domain settings match on the Network Server computer
and Database Server computer.

Procedure

1.
2.
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Log on to the computer as a user with administrator rights.

Browse to the shared folder on the Network Server. For example, \\Servername
\RBMnet, where Servername is the computer's name.

Important
Do NOT use a mapped drive path.

Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

Follow instructions presented by the installation program.
Accept the license agreement and click Next.

At the ATTENTION!! dialog, click Yes if you are installing the software for the first
time. If you are upgrading your software, this is a reminder to stop the installation
and back up your database first. Click No to stop the installation.

At the Options page dialog, make changes to the Select Features to Install list, if
desired.

You can install certain additional features on other computers in the AMS Machinery

Manager network. The Network Server option is disabled here since only one
network server is allowed on an AMS Machinery Manager network.

* Toinstall a Secondary Database server, select Database Server.
* (Optional) To install the Client, select Client.

* Uncheck features you do not want to install on this computer.
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You can change the default destination location and configuration location on your
database server. These tabs are disabled for updates.

8. Click Install to start the installation.

The Installing Components screen displays the status of the installation.

Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you
may need to contact Emerson Process Management Product Support.

9.  Continue through the installation steps and follow prompts.

10.  On the Finish page, click Finish to complete the installation.

If the computer requires a reboot, Restart Now is selected on the Finish page. Allow
the system to reboot before attempting to run the software.

The secondary database server can be accessed through the Network Server. The files are
installed in C:\RBMDBSRYV by default.

Postrequisites

. In Windows Explorer, browse to C:\RBMDBSRV and create new folder named CustData.
Share the CustData folder so it is available on the AMS Machinery Manager network.

. Add the database server in RBM Network Administration. Refer to the Administration
topics in AMS Machinery Manager Help for more information.

Install an Online Server

Note

Unless otherwise specified, a CSI Machinery Health Monitor is pre-configured with a database
created according to customer specifications. The Online Server has been set up during
commissioning.

You can install additional Online Servers and commission additional CSI Machinery Health
Monitors on your AMS Machinery Manager network. If you install an additional Online
Server, select Database Server as well.

Prerequisites

. Install the AMS Machinery Manager Network Server on the server first.

. Verify the workgroup or domain settings match on the Network Server computer
and Database Server computer.

Procedure

1. Logon tothe computer as a user with administrator rights.
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2. Browse to the shared folder on the Network Server. For example, \\Servername
\RBMnet, where Servername is the computer's name.

Important
Do NOT use a mapped drive path.

3. Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

4.  Follow instructions presented by the installation program.
5.  Atthe AMS Machinery Manager Setup - Options page, select Online Server and
Database Server.
* (Optional) Toinstall the Client, select Client.
* Uncheck features you do not want to install on this computer.
Continue through the installation steps and follow prompts.

In Windows Services, verify the following services are started.

e (CsiO_Server
* CsiMtdbMgr
e CSI_MhmRemote

Postrequisites

. In Windows Explorer, browse to C:\RBMDBSRV and create new folder named CustData.
Share the CustData folder so it is available on the AMS Machinery Manager network.

. Set up the Online Server in RBM Network Administration. Refer to the Administration
topics in AMS Machinery Manager Help for more information.

3.7 Install Data Import Server and Data Import
Client

The Data Import Server and Data Import Client are only available if you license the Data
Import functionality (included with network systems). You can install Data Import Server
and Data Import Client together or separately on the Network Server or on other
computers in the AMS Machinery Manager network.
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Install Data Import Server or Client on an existing
Network Server

Follow instructions to update or install new features on the Network Server. See
Section 3.9. At the Options pane, choose the Data Import Server and/or Data Import Client.
If you choose Data Import Client, AMS Machinery Manager Client is automatically selected.

Data Import Client is required to be installed in the same directory as the AMS Machinery
Manager Client.

Install Data Import or Client on a Secondary Server or
Workstation

Prerequisites

. Ensure the computer meets the minimum system operating requirements.
. Verify the workgroup or domain settings match on the Network Server computer
and Database Server computer.

Procedure

Log on to the computer as a user with administrator rights.

2. Browse to the shared folder on the Network Server. For example, \\Servername
\RBMnet, where Servername is the computer's name.

Important
Do NOT use a mapped drive path.

3. Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

4.  Accept the license agreement and click Next.
5.  Atthe Options pane, choose the Data Import Server and/or Data Import Client.

If you choose Data Import Client, AMS Machinery Manager Client is automatically
selected. Data Import Client is required to be installed in the same directory as the
AMS Machinery Manager Client.

6. Click Install to start the installation.

The Installing Components screen displays the status of the installation.
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Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you
may need to contact Emerson Process Management Product Support.

7. Onthe Finish page, click Finish to complete the installation.

If the computer requires a reboot, Restart Now is selected on the Finish page. Allow
the system to reboot before attempting to run the software.

3.8 Install Collaboration Tool

When Collaboration Tool is installed with AMS Machinery Manager Network Server and
Clients, users logged into the Clients using the same Network Server can communicate
with one another and share multiple types of information with other Collaboration Tool
users.

3.8.1 Install Collaboration Tool on the Network Server

When you install Collaboration Tool on the Network Server the MHM Peer Resolver Service
(MHMPeerResolverService.exe) is installed.

Prerequisites

. Install the AMS Machinery Manager Network Server on the server first.
. Install AMS Machinery Manager Client on the Client computer.

Procedure

1. On the Network Server, use Windows Explorer to browse to the RBMnet folder. For
example, C:\RBMnet.
Browse to Install\CollaborationTool.

Double-click setup.exe and continue through the installation.

Important
On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

4.  Accept the license agreement and click Next.
5.  ClickInstall to start the installation.

The Installing Components screen displays the status of the installation.

Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you
may need to contact Emerson Process Management Product Support.
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6.  Onthe Finish page, click Finish to complete the installation.

Install Collaboration Tool on the Client

Prerequisites

. Install the AMS Machinery Manager Network Server on the server first.
o Install AMS Machinery Manager Client on the Client computer.

Procedure
1. Logon tothe computer as a user with administrator rights.
2.  Browse to the shared folder on the Network Server. For example, \\Servername

\RBMnet, where Servername is the computer's name.

Important
Do NOT use a mapped drive path.

3. Browse to Install\CollaborationTool.
4.  Double-click setup.exe and continue through the installation.
Important

On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

Accept the license agreement and click Next.

Follow instructions presented by the installation program.

Launch Collaboration Tool

1. Launch AMS Machinery Manager Client.
2. From the main menu, select View > Collaboration Tool.

Initially, Collaboration Tool opens on the right side of the AMS Machinery Manager Client
screen.

Refer to Collaboration Tool topics in AMS Machinery Manager Help for more information.

Update or install new features on the Network
Server

When you install the Network Server, you can choose which features to install. You can
install the additional features on the Network Server later, by running the installation
program on the server where you have AMS Machinery Manager installed.
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Note

You must register the software when you update the software.

Prerequisites

Close all AMS Machinery Manager programs.
Stop AMS Machinery Manager services.

Procedure

1

2.
3.
4
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Log onto the Network Server as a user with administrator rights.

Close AMS Machinery Manager and stop any AMS Machinery Manager services.
Browse to the Network Server's installation folder, for example C:\RBMnet.

Run RBMsetup.exe.

Important

On Windows 7 and Windows Server 2008, right-click RBMsetup.exe and select Run as
administrator. Click Cancel if the installation launches automatically when you insert the DVD.
You must run the installation manually.

At the maintenance screen, select Add/Update and click Next.

At the Options pane, choose the features to install or leave the defaults selected for
an update.

Click Install to start the installation.

The Installing Components screen displays the status of the installation.

Note

Once the install is underway, there will be a point where the Cancel button is disabled. Do not
try to end the install if the Cancel button is disabled. If the install aborts after this point, you
may need to contact Emerson Process Management Product Support.

On the Finish page, click Finish to complete the installation.

If the computer requires a reboot, Restart Now is selected on the Finish page. Allow
the system to reboot before attempting to run the software.
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4.1

4.1.1

4.1.2

Additional installations

Topics covered in this chapter:

*  Install Machine History Viewer

*  Install AMS Standalone Data Transfer

*  Install AMS Machinery Manager ODBC Driver

e Install AMS Machinery Manager CSI Data Provider
*  Install CSI USB drivers

Install Machine History Viewer

Machine History Viewer works in conjunction with AMS Machinery Manager and other AMS
Suite software programs to allow you to view and analyze the operating history of a
facility’s rotating machinery. Machine History Viewer is a browser-based application that
can be accessed from any network computer.

Install Internet Information Services (IIS)

Install Internet Information Services (I1S) with the following features:

. IIS Management Console
. IIS Application Development Features (World-wide Web Services)
- .NET Extensibility
- ASP
- ASP.NET
- ISAPI Extensions
- ISAPI Filters

- Server-side Includes

Tip
In Windows 7, open Control Panel, select Turn Windows Features On or Off and select the features from
Internet Information Services and World Wide Web Services.

In Windows Server 2008, use the Add Roles Wizard to install the Web Server (1IS) role.

Install Machine History Viewer on the Network Server

Machine History Viewer installation includes the following components:

. AMS Machinery Manager Network Server

. Machine History Viewer Web Service
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. Machine History Viewer Client User Interface
o Microsoft SQL Server 2005 or Microsoft SQL Server 2005 Express

Machine History Viewer can be installed in three configurations:

1. Compact configuration: Install Machine History Viewer on the same server-class
computer as AMS Machinery Manager Network Server and Microsoft SQL Server
2005 for a compact configuration.

2. Recommended configuration: Install Network Server on one server-class machine
and install Machine History Viewer and Microsoft SQL Server 2005 on a separate
server-class computer.

3. Distributed configuration: Install each required component of Machine History
Viewer on separate server-class computers.

The instructions describe how to install either the compact configuration and
recommended configuration.

Prerequisites

. Install the AMS Machinery Manager Network Server on the server first.

. The Machine History Viewer version must match Network Server.

. Install IIS 5.2 or newer first. (Install IS before the .NET Framework, available during
installation).

Note

. Microsoft SQL Server 2005 is required by and installed with Machine History Viewer.

. Microsoft .NET Framework 2.0 is required by and installed with Microsoft SQL Server 2005
Express.

. Microsoft .NET Framework 4.0 is required by and installed with Machine History Viewer Web
Service and the Machine History Viewer Client User Interface.

Procedure

1. Insert the AMS Machinery Manager Software Installation DVD and openiitin
Windows Explorer.
Browse to the Install\MachineHistoryViewer folder.

Double-click setup.exe and continue through the installation.

Important
On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

4.  Accept the license agreement.

5.  The Configuration window displays. Choose the components to install on this
computer and click Next.

* Forthe compact configuration and the recommended configuration, check both
Web Service and Client Ul
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10.

11.

12.
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* Forthe distributed configuration, launch the installation on each computer;
choose only the Web Service feature on one computer, and only the Client Ul
feature on the other computer.

Click Yes if prompted to install the Microsoft .NET Framework.

It may take several minutes to complete the installation. This step applies if
Microsoft .NET Framework is not already installed.

A dialog may display the process of the Microsoft Report Viewer redistributable files
installation.

In the Select Computer for SQL Server 2005 dialog, choose where to install the SQL
server and click Next.

* Foracompact configuration and the recommended configuration, select This
computer (maximizes performance).

* Forthe distributed configuration, select A separate computer (may degrade
performance). A dialog displays additional instructions for this setup.

Note

If Microsoft SQL Server 2005 is already installed, this installation process creates new instance
named “EPM2005”. If you run the installer again, the Microsoft SQL Server 2005 does not
need to install additional instances.

When prompted, type a password to be used as part of the SQL connection string
and click Next. The SQL server installs automatically.

A summary of the SQL configuration displays. Make a note of this information for
future reference.

Computer Name:

SQL Server Instance Name: EPM2005

Strong Password:

(Distributed configuration only.) If you chose to install the SQL server on a separate
computer, the Database Server Login dialog appears. Provide the information to
connect to the SQL server on the separate computer.

Review the Disk Space Requirements for Local and Mapped Drives dialog to
determine where you want to install the selected Machine History Viewer
components. Click OK.

In the Choose Destination Location dialog, click Next to accept the default location
(recommended), or click Browse and select a different location for the selected
Machine History Viewer components.

When prompted, enter the network name of the computer where the Network
Server is installed.

You must specify the computer name if the installation is not on the same computer
as the Network Server.
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13. (Distributed configuration only.) When prompted, enter the network name of the
computer hosting the Machine History Viewer Web Service.

Note

You must specify the computer name where the Machine History Viewer Web Service is
installed, if you are installing only the Machine History Viewer Client User Interface.

14.  On the Start Copying Files screen, click Next to install the software components
listed.

The Setup Status screen displays a progress bar.

15.  When the URL displays, make a note of the address so you can access Machine
History Viewer.

Example: http://Servername/MachineHistory where Servername is the name of the
computer where Machine History Viewer is installed.

Machine History Viewer URL:

Note

If you are unable to log in, follow the instructions in Internet Explorer Help to enable cookies
for this URL.

16.  Onthe Finish page, click Finish to complete the installation.

4.1.3 Launch Machine History Viewer
Prerequisites

. Verify the client computer meets the operating requirements for a workstation.

. Use Internet Explorer 7.0 or newer with cookies enabled for the URL displayed
during installation.

. In RBM Network Administration, create an AMS Machinery Manager username and
password to use with Machine History Viewer.

. In RBM Network Administration, add a database to the user's database list, or allow
the user to access the master database list. If the user does not have a database, no
data will be visible to this user through Machine History Viewer.

Procedure
1. Launch Internet Explorer and enter the URL address you recorded during installation.
2. Loginwith auser name and password.

More information about using Machine History Viewer is provided in Online Help available
afteryoulogin.
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4.2 Install AMS Standalone Data Transfer

AMS Standalone Data Transfer allows you to transfer route files between an analyzer and a
folder on the computer or network. You do not need direct access to an AMS Machinery
Manager client or database. When you receive a route definition file, load it to your

analyzer with AMS Standalone Data Transfer. After you collect data, dump the route using
AMS Standalone Data Transfer and return the route data file.

Note
Only install AMS Standalone Data Transfer on a computer where AMS Machinery Manager is NOT
installed.
Procedure
1. Insert the AMS Machinery Manager Software Installation DVD and open it in
Windows Explorer.
Browse to Install/StandaloneDataTransfer.
Double-click setup.exe and continue through the installation.
Important
On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.
4.  Accept the license agreement.
5. Follow instructions presented by the installation program.
Windows Device Driver Installation Wizard prompts you to install the CSI USB
Drivers.
Install the CSI USB Drivers.
Follow instructions presented by the installation program.
At the Windows Security prompt, click Install to install the drivers.
The drivers install automatically.
9. Click Finish.
The CSI USB Drivers installation wizard closes.
10.  Click Finish.

4.3 Install AMS Machinery Manager ODBC Driver

You can install the AMS Machinery Manager ODBC driver in order to access your
information from third party software such as Microsoft Access™, Crystal Reports™, or
ORACLE®,
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Note
This installation is optional and not required by AMS Machinery Manager.

Procedure
1.  Gotothe computer where you want the driver installed.
You can install the driver on any computer where the AMS Machinery Manager

Client is installed.

2. Insert the AMS Machinery Manager Software Installation DVD and openiitin
Windows Explorer.

3. Browse to the Install\csiODBC folder.
Double-click setup.exe and continue through the installation.

Important
On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

Accept the license agreement.

When the Choose Destination Location screen appears, use the default location, and
click Next.

7.  Inthe Ready to Install Program screen, click Next to begin the installation.

The Setup Status screen displays the status of the installation.

8.  When the Installation Complete screen appears, click Finish.

If the screen displays a message to restart the computer, you must restart the
computer before attempting to use the software.

Install AMS Machinery Manager CSI Data
Provider

The AMS Machinery Manager CSI Data Provider works with AMS Machinery Manager
Network Server to supply information to applications such as AMS Asset Portal and AMS
Suite: Asset Performance Management. AMS Machinery Manager sends Assets, Active
Alerts and Event History. The Alert details are generated from alarms that are set in the
databases, such as the Vibration alarms for Export. Event details are generated from
RBMview when a new problem is created.

Verify you have a version of AMS Machinery Manager that supports your application:

. AMS Machinery Manager version 4.81 or later is required to support AMS Asset
Portal 1.0 or newer.

. AMS Machinery Manager 5.5 or later is required to support AMS Suite: Asset
Performance Management.
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4.4.1

4.4.2

Install Internet Information Services (IIS)

Install Internet Information Services (I1S) with the following features:

. IIS Management Console
. IIS Application Development Features (World-wide Web Services)
- .NET Extensibility
- ASP
- ASP.NET
- ISAPI Extensions
- ISAPI Filters

- Server-side Includes

Tip
In Windows 7, open Control Panel, select Turn Windows Features On or Off and select the features from
Internet Information Services and World Wide Web Services.

In Windows Server 2008, use the Add Roles Wizard to install the Web Server (lIS) role.

Install CSI Data Provider

Install the CSI Data Provider on the same computer as the AMS Machinery Manager
Network Server or on a different computer with network access to the Network Server.

Prerequisites
An AMS Machinery Manager Client must be installed on the Network Server computer.
The CSI Data Provider version must match the Network Server.

CSI Data Provider requires the Microsoft .NET Framework 4.0, available during the
installation. 1IS must be installed before Microsoft .NET Framework 4.0.

Procedure
1.  Gotothe computer where the AMS Machinery Manager Network Server is installed,

or a computer with network access to the Network Server.

2. Insert the AMS Machinery Manager Software Installation DVD and open it in
Windows Explorer.

3. Browse to Instal\CSIDataProvider.

Double-click setup.exe and continue through the installation.

Important
On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

Accept the license agreement and click Next.

Continue through the installation steps and follow prompts.
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10.

11.
12.

The installation program checks the minimum system requirements for the
software. If the computer is missing any required software, you will be prompted to
install the necessary software.

On the Disk Space Requirements screen, review this information and click OK.

On the Choose Destination Location page, use the default location and click Next.
When prompted, enter the name of the computer running Network Server and click
Next.

The Data Provider must be able to locate the Network Server to function properly.

When prompted, install and start the CsiRVWmgr service on the Network Server.

Complete the following steps on the Network Server.

a. Onthe Network Server, launch the Windows Command Prompt as
Administrator.

Tip
On Windows 7, Click Start > Accessories > Command Prompt, right-click Command Prompt and
select Run as Administrator.

b. Inthe Command Prompt window, type the command C;\RBMnet\RBMsuite\sys
\RVWmgr.exe -i and press Enter.

Example:

Microsoft Windows [Version 6.1.7601]
Copyright (c) 2009 Microsoft Corporation. All rights reserved.

C:\Windows\system32>C:\RBMnet|\RBMsuite|sys\RVwMgr.exe -i
C:\Windows\system32>

The CsiRVWmgr service is installed as a Windows Service.

c. Onthe Network Server, launch Windows Services.
d. Right-click the service named CsiRVWmgr and select Properties.
e. Inthe Properties dialog, choose Automatic from the Startup type menu.

This setting ensures the service restarts automatically if it is ever stopped, such
as after a reboot.

f. Click Start to start the CsiRVWmgr service.

The CsiRVWmgr service is installed and started.

Click OK to continue the installation.

When the URL displays, make a note of the address.

Example: http://Servername/CSIDataProvider/CSIDataProvider.asmx, where Servername is
the name of the computer where CSI Data Provider is installed.
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4.4.3

4.4.4

13.

You will need to use the URL to access the CSIDataProvider web service and register
the AMS Machinery Manager user.

Table 4-1: CSI Data Provider URL
CSI Data Provider URL:

Click Finish when the Installation Complete page displays.

Create a user for CSI Data Provider

See Create a new user in AMS Machinery Manager Help for details.

Procedure

1.

In RBM Network Administration, create a new user with guest access mode.

Important

Only use this username and password with CSI Data Provider. If these credentials are used by
some other user or application, the CSI Data Provider cannot access the system.

In RBM Network Administration, right-click the new user and select Edit User.

Click User Database List.

The Database List dialog appears.

To add a database, select the database from the System Databases pane and click
Add.

Click OK.

Register the user for CSI Data Provider

1.

MHM-97402, Rev 23

Launch Internet Explorer and type the web address displayed during installation.

Example: http://Servername/CSIDataProvider/CS|DataProvider.asmx, where Servername is
the name of the computer where CSI Data Provider is installed.

The CSI Data Provider web interface appears.
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@ CsiDataProvider Web Service - Windows Internet Explorer
@ @ b4 |(¢1 http://installtest/CSIDataProvider/CSIDataProvider.asmx - | ‘r| x | r

¢ Favorites | @@ CsiDataProvider Web Service -8

CsiDataProvider

The following operations are supported. For a formal definition, please review the Service Description.

GetAlertDetails

GetAlertList

GetAlertSeveritylist

GetAssetDetails

GetConfigurationInfo

GetEventCount

GetEventDetails

GetEventList

GetPlantHierarchy

GetServerInfo

Click the GetPlantHierarchy link.
On the GetPlantHiearchy page, enter the AMS Machinery Manager user name and
password in the format: username|password

For example, if “AOXS” is the user name and “aoxspwd1” is the password, enter:
AOXS|aoxspwd1.

GetPlantHierarchy

Test
To test the operation using the HTTP POST protocol, click the 'Invoke’ button.

Parameter \alue

credentials: AOQXS|aoxspwdl

4, Click Invoke.

A window displays a stream of XML statements. This is proof that you successfully
registered the user and CSI Data Provider is functioning properly.
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(& http://installtest/CSIDataProvider/CSIDataProvider.asmy/GetPlantHierarchy - Windows Internet Explorer

uu |é‘ http://installtest/C5IDataP rovider/CSIDataProvider.asmx/GetP lantHierarchy - | ‘f| X ‘ |7
7 Favorites | @& https//instalitest/CSIDataProvider/CSIDataProvid... - B

<?xml version="1.0" encoding="utf-8" ?=
- <plantHierarchyList xmins="http:/ /assetweb.com/2002/04/dataprovider"'>
- «<plantHierarchy plantName="PLANT">
- =folder name="Example.rbm">
- <folder name="MP50 - Mechanical Problems: 50Hz">
- <asset>
<key>101|M|4294967020</key >
<name>Machine 1</name=
<type=90 KW</type:>
<description=>Looseness in locknut</description=>
</asset>
- <asset>
<key=101|M|4294966563 </key >
<name=Machine 2</name=
<type=Screw Compressor</type:>
«<description>0Outer Race Screw Compressor</description=
<fasset>
- zasset>
<key>=101|M|4294966359 </key >
«name=Machine 3</name>
<type=Reduktor</type>
<description>0uter and Inner Race 113RPM </description:
</asset=
- <asset>
Done €& Local intranet | Protect

Note

If you get an error message, ensure that the CsiRVWmgr service is started and the user name
has been created with the password you entered.

4.4.5 Create a data source

Use the AMS Suite: Asset Performance Management (or Asset Portal Manager for use with
AMS Asset Portal) to create a data source. Refer to the respective product documentation
for more information.

4.4.6 Configure Web Server settings

In order for the CSI Data Provider to work correctly, the World Wide Web Publishing
service must be configured correctly.

Procedure
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Open Windows Services and start the service named World Wide Web Publishing
Service.

When you install the World Wide Web Publishing Service with Windows Server, it
may not be started by default. You must start the service in order to run a web
service.

(Windows Server 2003 only) Install ASP.NET as a Windows Service.

a. Launch the Windows Command Prompt as Administrator.
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4.5
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Tip
On Windows Server 2003, go to Start > Accessories > Command Prompt, right-click Command
Prompt and select Run as Administrator.

In the Command Prompt window, type the command aspnet_regiis.exe -s W3SVC/1/
ROOT/CsiDataProvider and press Enter.

Example:

Microsoft Windows [Version 6.1.7601]
Copyright (c) 2009 Microsoft Corporation. All rights reserved.

C:\Windows\system32>aspnet_regiis.exe -s W3SVC|/1/ROOT|CsiDataProvider

If ASP.NET is NOT installed, type the command aspnet_regiis.exe -i and press Enter.

Important

Only use this command with the -i argument if ASP.NET is NOT already on the computer;
it has the intrusive effect of updating all scriptmaps, both at and below the metabase
root.

By default, ASP.NET is not installed.

Enable ASP.NET to execute.

By default, the Web Service Extension status for ASP.NET is Prohibited. In IIS Manager,
change the status to Allowed.

Follow instructions for your version of IIS to enable ASP.NET. For example, follow
these instructions in I1S 7.0.

a.
b.
C.
d.

Launch lIS Manager.

Select the computer name node in the Connections pane.
In the Features view, select ISAPI and CGI Restrictions.

Select the ASP.NET service and change the status to Allowed.

Add CSIDataProvider to the Trusted Sites.

The first time the CSIDataProvider service runs, a security warning may appear. Add
this website to the computer’s trusted sites.

From this point, the CSIDataProvider will be granted access to this site.

Install CSI USB drivers

The USB drivers for the CSI 2140 or CSI 2130 analyzer are installed automatically with AMS
Machinery Manager or AMS Standalone Data Transfer. You can install the USB drivers on
any computer where you need to connect a CSI 2140 or CSI 2130 analyzer.
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Procedure

1.
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Insert the AMS Machinery Manager Software Installation DVD and open it in
Windows Explorer.

Browse to InstalN\CSI USB Drivers.

Double-click setup.exe and continue through the installation.

Important

On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

Accept the license agreement.
Follow instructions presented by the installation program.

At the Windows Security prompt, click Install to install the drivers.

The drivers install automatically.

Click Finish.
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5 AMS Machinery Manager services

Topics covered in this chapter:

*  Primary server features and services
*  Secondary server features and services
*  (lient installation features

5.1 Primary server features and services
The Primary server is the computer hosting the Network Server.
Feature installed Service installed Description Purpose
Standalone or Network = CsiNetAdmin Network Server Licensing
Server CSI_MhmRemote AMS Remote Manages connections between AMS
Machinery Health Machinery Manager Clients and the
Manager Network Server.
CSI Data Transfer Data Transfer Service | Enables CSI Machinery Health Analyzer to
Service connect and transfer data to AMS
Machinery Manager over an Ethernet
connection.
CSIMtDbMgr Service Database Server Database read/write/indexing
AMS Machinery n/a AMS Machinery Manager user interface.
Manager Client
Collaboration Tool MHM Peer Resolver Collaboration Tool When installed on the Network Server, this
(optional) Service communication service enables communication between
management AMS Machinery Manager users with
Collaboration Tool installed on their
workstation.

5.2 Secondary server features and services

One or more of these features can be installed on a computer in the AMS Machinery
Manager network after a Network Server has been installed.

Feature installed Service installed Purpose

Database Server CSIMtDbMgr Service Database read/write/indexing

Data Import Server CSI Data Import Service Enables AMS Machinery Manager to read MODBUS data
from other systems.
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Feature installed Service installed Purpose
Online Server CsiO_Server Enables AMS Machinery Manager to manage and collect
data from CSI Machinery Health Monitors.
AMS Machinery Manager | n/a AMS Machinery Manager user interface.
Client
5.3 Client installation features

One or more of these features can be installed after the Primary server has been installed.

Additional installation Service installed Purpose

Collaboration Tool n/a Available with network client installations to allow AMS
Machinery Manager users to communicate.

Online Watch n/a A client application provides a read-only view of online
system status. Can also be configured to allow a user to
acknowledge or modify alarms and request data

acquisitions.
Machine History Viewer n/a Provides a read-only view of periodic data and
equipment case history through a web browser.
AMS Standalone Data n/a Allows users of a CSI Machinery Health Analyzer at a
Transfer location without access to a database to load and dump

routes and route data as files.
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6.1

6.1.1

Configure network computer
communication

Topics covered in this chapter:

*  Configure firewall settings
. Service accounts

If services running on secondary servers have trouble establishing a connection with the
primary server, you can change firewall settings to allow the services to communicate with
one another. You can also create service accounts to assign to each AMS Machinery
Manager program and service.

Configure firewall settings

AMS Machinery Manager programs communicate with each other using communication
ports. If you have a firewall, the ports used by the AMS Machinery Manager programs are
often blocked (or disallowed) by default. During installation, Windows may prompt you to
allow access for certain AMS Machinery Manager programs on the server. If you choose to
allow access, Windows creates firewall exceptions. You may need to configure other
firewall rules manually. Configure your firewall program to allow communication between
AMS Machinery Manager programs and the ports they use on each computerin the AMS
Machinery Manager network.

Note

Each AMS Machinery Manager program needs a firewall exception to access the primary server, even
if all the programs are installed on the primary server.

Primary server ports

These services make up the core programs installed as a Standalone or Network
installation.

Table 6-1: Primary server ports

Port name Port Type | Service Executable Connection Purpose

CSIDB_SERVER 10045 | TCP CsiMtdbMgr mtdbmgr.exe server services, Database read/
client programs  write/indexing

CSIDB_ADMIN 10046 | TCP CsiMtdbMgr mtdbmgr.exe server services, CsiMtdbMgr
client programs

CSINA_SERVER 10047 TCP CsiNetAdmin NetAdmin.exe server services, Licensing
client programs
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Table 6-1: Primary server ports (continued)

Port name Port Type | Service Executable Connection Purpose

CSINA_ADMIN 10048 TCP CsiNetAdmin NetAdmin.exe server services, Licensing
client programs

CSINA_PEER 10049 TCP CsiNetAdmin NetAdmin.exe server services, Licensing

client programs

CSIMHMREMOTE

10052 TCP CSI_MhmRemote | MhmRemote.exe | server services, Manage AMS
client programs | Machinery Manager
Client connections.

CSIRBMCOMSR

10077 | TCP CSl Data Transfer | DeviceServer.exe | CSlanalyzers Enable data
Service using Ethernet transfer over
Ethernet.

6.1.2

Ports for Data Import server

Table 6-2: Ports for Data Import server

Port name Port Type | Service Executable Connection Purpose
CSIDISERVER 10060 | TCP CSI Data Import | Datalmport.exe Provides Machinery
Service Health Manager
MODBUS Data
Import.

6.1.3

Database Server ports

Firewall ports required for additional database servers installed on the AMS Machinery
Manager network.

Table 6-3: Database Server ports

Port name Port Type | Service Executable Connection Purpose

CSIDB_SERVER 10045 | TCP CsiMtdbMgr mtdbmgr.exe server services, Database read/
client programs | write/indexing

CSIDB_ADMIN 10046 | TCP CsiMtdbMgr mtdbmgr.exe server services, Database read/

client programs | write/indexing

CSIMHMREMOTE

10053 TCP CSI_MhmRemote | MhmRemote.exe | server services, Manage AMS
client programs | Machinery Manager
Client connections.
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6.1.4 Ports for Collaboration Tool server

Table 6-4: Ports for Collaboration Tool server

Port name Port Type | Service Executable Connection

Purpose

HTTP 8090 TCP MHM Peer MHMPeerResolver | client programs
Resolver Service | Service.exe

Handles
registration of
Collaboration Tool
clients to
communicate with
one another.

6.1.5 CSI Data Provider ports

Table 6-5: CSI Data Provider ports

Port name Port Type | Service Executable Connection Purpose
CSIVW_SERVER 10050 | TCP CsiRvWmgr RVWmgr.exe Asset Portal, Provides alert
external information.
programs
CSIVW_ADMIN 10051 TCP CsiRvWmgr RVWmgr.exe Asset Portal, Provides alert
external information.
programs
HTTP 80 TCP IS inetinfo.exe Asset Portal, Provides alert
external information.
programs
6.1.6 Ports for Machine History Viewer server
Table 6-6: Ports for Machine History Viewer server
Port name Port Type | Service Executable Connection Purpose
HTTP 80 TCP 1S inetinfo.exe external Provides web
programs access to case
histories.
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6.1.7

Ports required for servers hosting a shared Custdata
folder

Table 6-7: Ports required for servers hosting a shared Custdata folder

Port name Port Type | Service Executable Connection Purpose
epmap 135 TCP DCE endpoint SYSTEM external Windows File
resolution programs Sharing
epmap 135 UDP | DCE endpoint SYSTEM external Windows File
resolution programs Sharing
netbios-ns 137 TCP NETBIOS Name SYSTEM external Windows File
Service programs Sharing
netbios-ns 137 UDP | NETBIOS Name SYSTEM external Windows File
Service programs Sharing
netbios-dgm 138 UDP | NETBIOS SYSTEM external Windows File
Datagram Service programs Sharing
netbios-ssn 139 TCP NETBIOS Session | SYSTEM external Windows File
Service programs Sharing
microsoft-ds 445 TCP Microsoft SYSTEM external Windows File
Directory Service programs Sharing
microsoft-ds 445 UDP | Microsoft SYSTEM external Windows File
Directory Service programs Sharing

6.1.8

Ports required for AMS Machinery Manager Clients and
Data Import Clients

Table 6-8: Ports required for AMS Machinery Manager Clients and Data Import Clients

Port
name Port Type | Service Executable Connection Purpose
*.exe varies TCP | MHM client C:\RBMclient\sys\*.exe | server services, Each AMS Machinery
programs C:\RBMsuite\sys\*.exe | online systems Manager program.
6.1.9 Online Server ports
Table 6-9: Online Server ports
Port name Port Type | Service Executable Connection Purpose
odh_4500T 19788 | TCP CsiO_Server O_Server.exe online systems Online system
communication.
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Table 6-9: Online Server ports (continued)

Port name Port Type | Service Executable Connection Purpose
odh_4500su 19798 TCP CsiO_Server O_Server.exe online systems Online system
communication
odh_4500_tcp 19799 | TCP CsiO_Server O_Server.exe online systems Online system
communication
odh_4500_udp 19799 uDP CsiO_Server O_Server.exe online systems Online system
communication
odh_admin-tcp 19800 TCP CsiO_Server O_Server.exe online systems Online system
communication
odh_config-tcp 19801 TCP CsiO_Server O_Server.exe online systems Online system
communication
odh_status-tcp 19802 TCP CsiO_Server O_Server.exe online systems Online system
communication
odh_status-udp | 19802 UDP CsiO_Server O_Server.exe online systems Gross Scan
broadcast
odh_fallback-tcp = 19803 TCP CsiO_Server O_Server.exe Fallback server Fallback server
(legacy, no longer
used)

6.1.10

Ports for OPC data

Online Systems can be configured to provide data to control systems using OPC (Object

Linking and Embedding for Process Control). The ports used by the Online Server to
provide OPC data are assigned dynamically from the range of DCOM ports Windows is

configured to use. These ports are not required to be open if tunneling software is used.

Table 6-10: Ports for OPC data

Port name Port Type | Service Executable Connection Purpose
epmap 135 TCP DCE endpoint SYSTEM external Windows File
resolution programs Sharing
epmap 135 UDP | DCE endpoint SYSTEM external Windows File
resolution programs Sharing
- varies TCP CsiO_Server O_Server.exe external Provides OPC
programs information

6.1.11

FTP ports

Servers set up to provide firmware updates to online systems use FTP ports.
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Table 6-11: FTP ports

Port name Port Type | Service Executable Connection Purpose
FTPDATA 20 TCP FTP data inetinfo.exe external FTP data transfer
connection programs, online
systems
FTP 21 TCP FTP control inetinfo.exe external FTP data transfer
connection programs, online
systems

6.1.12

Optional ports for troubleshooting

Table 6-12: Optional ports for troubleshooting

Port name Port Type | Service Executable Connection Purpose
Telnet 23 TCP Telnet client varies external systems | Telnet
ICMP - - Ping SYSTEM external systems | Ping

6.2

6.2.1

52

Service accounts

Service accounts are not required, but can be useful on a network system if services
running on secondary servers have trouble establishing a connection with the primary
server. Try updating the firewall settings first. If changing the firewall settings does not
resolve the issue, you can create service accounts to assign to each AMS Machinery
Manager program and service.

After you install AMS Machinery Manager on the server, create a service account on the
server and assign it to each AMS Machinery Manager service. Then create an identical
account on each computer where AMS Machinery Manager services are installed. This
includes any computer where you install any AMS Machinery Manager features, but not
computers where you install only the AMS Machinery Manager Client. The Client does not
have a service.

Create a service account

Create a service account after installing AMS Machinery Manager.
Prerequisites

Verify you can launch the AMS Machinery Manager Client.
Procedure

1. Follow your operating system's instructions to create a new user account with the
following information:

MHM-97402, Rev 23




Configure network computer communication

6.2.2

e User name: MHMSERVICE
o Password; ******
e (lear the check box User must change password at next logon.
» Select User cannot change password.
2. Addthe MHMSERVICE user as a member of the computer's Administrators group.

Postrequisites

Assign this services account to all AMS Machinery Manager services on the computer.

Assign the services account to each AMS Machinery
Manager service

Assign the services account to each AMS Machinery Manager service on the computer.

Procedure
1. Launch Windows Services on a computer where AMS Machinery Manager programs
are installed.

Identify the AMS Machinery Manager services to be updated.

Right-click the service and select Properties.

In the Properties dialog, select the Log On tab, and update the log on information so

the service operates using the services account.

* This account: \MHMSERVICE (The dot and backslash are required before the
username.)

o Password: ******

Note
The password you enter must match the password assigned to the account.

5. Restart the service.
6.  Repeatthis procedure for each AMS Machinery Manager service.

Postrequisites

You can test the services account by launching the AMS Machinery Manager Client. If the
Client launches, the accounts have been created and assigned correctly. If it does not
launch, there may be a problem with one of the users. If you do not have a Client installed,
test the specific service by verifying its functionality works.
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Appendix A
File locations

File locations depend on the type of installation.

. Standalone systems use absolute paths (for example, C:\RBMsuite), because all the
AMS Machinery Manager applications that use this path are installed on the same

computer.

o Network systems use network paths (UNC format) (for example \\ServerName\RBMnet
\RBMsuite), so applications on all AMS Machinery Manager Client workstations can
access the files.

Standalone installation

All of the AMS Machinery Manager files are located in the installation directory, C:\RBMsuite,

by default.

Table A-1: Standalone installation file types and locations

Category Type Location
Installation Folder C:\RBMsuite
Directory
AMS Machinery Executable C:\RBMSuite\Sys
Manager System Dynamic Linked C:\RBMSuite\Sys\Plugins
Files Library
Error Messages C:\RBMSuite\Sys\HelpMsg
Help Files C:\RBMSuite\Sys\HelpMsg
Drivers Drivers C:\RBMSuite\Sys\Drivers
System Data Files | System Data Files C:\RBMSuite\SysData

Template Files

C:\RBMSuite\SysData\Template

Oil Instrument Files

C:\RBMSuite\SysData\Instrmnt

Report Templates | C:\RBMSuite\SysData\Report
Customer Data Shared Data Files C:\RBMSuite\CustData
Files
User Data Files User Data Files C:\RBMSuite\Users

Network installations

Table A-2 and Table A-3 show where to find files on each installation. The Network Server
files are located in C:\RBMnet. The Network Server shared files are listed by UNC path (for
example, \\Servername\RBMnet\RBMsuite\ where Servername is the network name of the
Network Server computer). Each Client workstation has some files stored locally in C:

\RBMclient\.
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Table A-2: Network Single- or Multiple-License Server file types and locations

Category Type Location
Installation Folder C:\RBMnet
Directory
Network Server | UNC Path \\Servername\RBMnet
Shared Folder
AMS Machinery | Executables \\Servername\RBMnet\RBMSuite\Sys
Manager System | by namic Link \\Servername\RBMnet\RBMSuite\Sys\Plugins
Files Library
Error Messages \\Servername\RBMnet\RBMSuite\Sys\HelpMsg
Help Files \\Servername\RBMnet\RBMSuite\Sys\HelpMsg
Drivers Drivers \\Servername\RBMnet\RBMSuite\Sys\Drivers

System Data Files

System Data Files

\\Servername\RBMnet\RBMSuite\SysData

Template Files

\\Servername\RBMnet\RBMSuite\SysData\Template

Oil Instrument Files

\\Servername\RBMnet\RBMSuite\SysData\Instrmnt

Report Templates

\\Servername\RBMnet\RBMSuite\SysData\Report

Customer Data
Files

Databases

\\Servername\RBMnet\RBMSuite\CustData

User Data Files

User Data Files

\\Servername\RBMnet\RBMSuite\Users

User Preferences

\\Servername\RBMnet\RBMSuite\Sys\AMS_Preferences\AMS _
UserPreferences

CMMS Data Files

CMMS Shared Files

\\Servername\RBMnet\CMMSData

Table A-3: Network Client file types and locations

Category Type Location

Installation Folder C:\RBMclient\

Directory

AMS Machinery | Executable C:\RBMclient\Sys

';/ill‘l:ager System Dynamic Link Library | C:\RBMclient\Sys\Plugins
Error Messages C:\RBMclient\Sys\HelpMsg
Help Files C:\RBMclient\Sys\HelpMsg

Drivers Drivers C:\RBMclient\Sys\Drivers

System Data Files

System Data Files

C:\RBMclient\Sys\SysData

Template Files

C:\RBMclient\Sys\SysData\Template

Oil Instrument Files

C:\RBMclient\Sys\SysData\Instmnt

Report Templates

C:\RBMclient\Sys\SysData\Report

Customer Data
Files

Databases

\\Servername\RBMnet\RBMSuite\CustData

User Data Files

User Data Files

\\Servername\RBMnet\RBMSuite\Users
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Table A-3: Network Client file types and locations (continued)

Category

Type

Location

User Preferences

C:\RBMclient\Sys\AMS_Preferences\AMS_UserPreferences

CMMS Data Files

CMMS Shared Files

\\Servername\RBMnet\CMMSData

File Descriptions

Table A-4: File category and type descriptions

Category

Type

Description

System Files

Executables (*.exe)

AMS Machinery Manager applications.

Dynamic Link Libraries
(*.dlly

Shared AMS Machinery Manager run-time libraries.

OCX files (*.ocx)

Shared AMS Machinery Manager object libraries.

Compressed help files
(*.chm)

The help files and manuals.

System Data
Files

CSI Component Files
(*.wh)

Warehouse files store reusable components and
equipment configurations.

Report Templates
(*.rpt)

Report templates for RBMview.

User Data Program Configuration | Configuration files that store user options and

Files Files (*.def, *.ini) preferences for the applications.

CMMS Data = CMMSLink Files (*.mdb) | Define the interface to CMMS systems and facilitate the
Files exchange of information to and from CMMS systems.
Customer AMS Machinery AMS Machinery Manager databases.

Data Files Manager 4.xx and 5.xx

Databases (*.rbm)

Writable DbLookup Files

These provide global reference information such as fault
codes and severity descriptions. If used in a Network
Multiple-License installation, these files are located on
the Enterprise data directory.

NetAdmin Files

These files are used for user access administration.

RBMwizard Answers
Files/Equipment
Configuration Files
(*.dbz)

RBMwizard databases that store database setup and
equipment configuration information.

Oil Reference Files
(*.ref)

Oil reference information.

Database Files (*.mdb)

AMS Machinery Manager database files.

External Envelope Files
(*.env)

Generated by Autostat and contain mainly statistical
envelope alarms created by Autostat. Plotdata, Export,
and Nspectr retrieve the alarms from the file during
analysis.
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Table A-4: File category and type descriptions (continued)

Category

Type

Description

User Component Files
(*.wh)

User-defined warehouse files that store reusable
components and equipment configurations.

Images (*.bmp, *.pcx,
*.tga, *.ann, *.eif,
*.jipg, *.tiff)

Images used for plot captures, IR thermography images,
etc.

Diagrams (*.bmp)

Images used for equipment diagrams.

Log Files (*.log)

Log files store information about applications and
operations helpful for troubleshooting.

Database Archives
(*.zip)

Databases archived using the AutoZip utility.

Online Database
Template (*.cvb)

Template of a database for Online technology for use
with Online Configuration.

Online Transient Archive
(*.bin)

Archive files for transient data collected with a CSI
Machinery Health Monitor.These files are saved in a
database's Archive folder.

Portable Transient
Archive (*.wfv *.ttt)

Archive files for transient data collected with a CSI
Machinery Health Analyzer. These files are saved in a
database's TransWF folder.

Additional
Files

csi.ini Configuration file for AMS Machinery Manager
applications in the Tools tab.
csiports.ini Defines the TCP/IP port numbers on which the database

server and network administration server communicate.

DBLookup.mdb

Quick reference file that stores the fault framework,
component types, and other lists used by the
applications.

enable.tbl Determines the number of users allowed and other
factors that are license-dependent.
mhm.exe Launches the AMS Machinery Manager Client.

mhm.exe.config

Main configuration file for AMS Machinery Manager
applications and settings.

rbm.exe

Main menu application for AMS Machinery Manager.

RBMadmin.exe

AMS Machinery Manager Network Administration.
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Appendix B
Register AMS Machinery Manager

Topics covered in this appendix:

e Register AMS Machinery Manager - Standalone system
. Register AMS Machinery Manager - Network system

You can register the software when prompted during installation. Or, you can cancel the
registration process, continue the installation, and register later.

Note
You must also register the software during a software update or repair.

B.1 Register AMS Machinery Manager - Standalone
system

Prerequisites

Log on as a Windows administrator user on the computer where you installed AMS
Machinery Manager.

Close AMS Machinery Manager Client.

In Windows Services, stop AMS Machinery Manager services, CsiNetAdmin and
CSIMtDbMgr Service.

Procedure

1. InWindows Explorer, go to C:\RBMsuite\sys and double-click Serial.exe.
2. Inthe Serial dialog, click Register Product.

The Register Product dialog appears. You need the Serial No. and Request No. during
registration.

3. Contact Product Support to register.

Phone: Toll free 888.367.3774, option 2 (U.S. and Canada)
+63.2.702.1111 (Rest of world)

Email: wwcs.custserv@AP.EmersonProcess.com

Web: http://www.mhm.assetweb.com/reg

4.  Enter the Response code given to you by a Product Support representative.

The code is only valid for your computer.
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Click OK.

The Register Product dialog closes.

In the Serial dialog, verify the Status is "Registered.
Click Close.

Your software is registered.

Postrequisites

Launch AMS Machinery Manager.

B.2 Register AMS Machinery Manager - Network
system

Prerequisites

Log on as a Windows administrator user on the computer where you installed AMS
Machinery Manager Network Server.

Close AMS Machinery Manager Client.

In Windows Services, stop AMS Machinery Manager services, CsiNetAdmin and
CSIMtDbMgr Service.

Procedure

1.
2.

60

In Windows Explorer, go to C:\RBMnet\RBMsuite\sys and double click Serial.exe.
In the Serial dialog, click Register Product.

The Register Product dialog appears. You need the Serial No. and Request No. during
registration.

Contact Product Support to register.

Phone: Toll free 888.367.3774, option 2 (U.S. and Canada)
+63.2.702.1111 (Rest of world)

Email: wwcs.custserv@AP.EmersonProcess.com

Web: http://[www.mhm.assetweb.com/reg

Enter the Response code given to you by a Product Support representative.

The code is only valid for your computer.
Click OK.

The Register Product dialog closes.

In the Serial dialog, verify the Status is "Registered."
Click Close.
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Your software is registered.

Postrequisites

Restart the services and launch AMS Machinery Manager.
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Appendix C

Update CSI Machinery Health Monitor
firmware

C.1

Topics covered in this appendix:

*  Install the firmware on the FTP server
e Reboot the CSI Machinery Health Monitor
*  Check the firmware version in AMS Machinery Manager

Emerson Process Management periodically releases updates to firmware. When you
update your AMS Machinery Manager software, it is a good practice to update the
firmware if a new version is available. Refer to the Readme file (Readme.rtf) on the
Software Installation DVD for information about the current firmware version. These
instructions apply to the following CSI Machinery Health Monitor systems:

. CS1 6500 Machinery Health Monitor

. CS12600 Machinery Health Expert

. CSI 4500 Machinery Health Monitor

Install the firmware on the FTP server

Prerequisites
You need the AMS Machinery Manager Software Installation DVD.
Procedure

1. Logon to the computer that hosts the FTP Server for your CSI Machinery Health
Monitor.
Insert the AMS Machinery Manager Software Installation DVD.
Open the DVD in Windows Explorer and browse to Install/Online Firmware.

Double-click setup.exe and continue through the installation.

Important
On Windows 7 and Windows Server 2008, right click setup.exe and select Run as administrator.

Accept the license agreement.

Select the type of installation.

» Select Typical to install the firmware and tools.

e Select Custom to choose to install either the firmware or the tools.
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C.2

C3

64

7.  Follow instructions presented by the installation program.
The online firmware is installed in C:\Inetpub\ftproot\bin\.
Postrequisites

Cycle the power on each CSI Machinery Health Monitor that uses this FTP server.

Reboot the CSI Machinery Health Monitor

Cycle power on the CSI Machinery Health Monitor and verify the system is in good status
after it boots.

Procedure

1. Cycle the power on each CSI Machinery Health Monitor that needs to get the new
firmware update from the FTP server.

Wait approximately 5 minutes for the system to complete the boot process.

Verify the system is powered on and in good status.

Refer to the Installation Manual for your specific hardware model for more
information.

Check the firmware version in AMS Machinery
Manager

1. Logonto AMS Machinery Manager Client with the Administrator user account or a
user that has permission to use online technology.

2. Go to Tools > Setup/Communications > Online Configuration.

The Online Config window appears.

3. Go to File > Online Server > Open.

The Select Online Server Host Computer dialog appears.

4, Choose a server name from the menu and click OK.

The Online Server opens and a tree structure appears in the left pane of the Online
Config window.

5.  Inthe tree structure, expand Units folder, and right-click the icon next to the CSI
Machinery Health Monitor you want to check and select Properties.

The Unit Properties screen appears in the right pane and displays the State,
Firmware Revision, DSP Revision, Total RAM, and Unit Type.
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Figure C-1: Unit properties

Unit Properties State: Node (Unit) Down

Abbreviation: Description:

Wﬁs_ | Test
CPU Ethernet Address:
o e

Firrmware Revision:

DSP Revision:

Total BAM:

Unit Type: C51 45000 Machinery Health Manitar

6. In the Unit Properties pane, verify State is Node(Unit)UP and Firmware Revision matches
the version you installed.

Contact Product Support for help if the firmware version does NOT match.
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